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• Rendering a spacecraft scene 
• Creatures and characters in ZBrush

• Create dramatic smoke effects
• Posing a character model 

• and much more!
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Tomi Väisänen shares his 
inspiring portfolio and 
insights into his career
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3 D C R E AT I V E :  2 0 0 5  –  2 0 1 6
It’s with heavy hearts that we’re announcing the end of 3dcreative 

magazine. From 2005 to the present, 3dcreative has aimed to 
deliver affordable, high quality resources and inspiration for 3D 
artists of all kinds – but with so many great 3D resources readily 

available online, and inevitable piracy to contend with, we’ve 
decided it’s time to draw 3dcreative to a close.

We’re very grateful to all the artists and readers who’ve supported 
the magazine, whether you’ve just discovered it or have been 

following from the early days. It’s been a great privilege for us to 
work with the hundreds of artists who’ve featured in 3dcreative 

over the last ten years. It wouldn’t have been possible without your 
kindness and contributions.

Subscriptions to 3dcreative are no longer available to buy. 2015 
is our last complete year of twelve issues, with this final January 
2016 issue released for free. You’ll still be able to find back issues 
in the 3dtotal shop, as well as our huge collection of eBooks and 

printed books, and we’ll continue to bring you brilliant 3D content 
and tutorials for free via the 3dtotal website. Our sister magazine, 
2dartist, is still ongoing for anyone interested in 2D art and digital 

painting. With the door closing on one project, we’ll use our time to 
bring you bigger, better content with a renewed energy. 

Thank you again to everyone who’s supported 3dcreative, whether 
by buying it or being in it, and we hope you continue to support us 
as we go forward into exciting new projects. We’ve got big plans for 

2016, and hope you do too. Stay creative!

The 3dcreative team

http://www.2dartistmag.com


3dtotal presents the new issue of 2dartist 
magazine, a downloadable monthly 
magazine for digital artists for only ₤2.99 
(approx. $4.79/€3.69).

Visit www.2dartistmag.com to see a full preview of the latest 
issue, subscription offers, and to purchase back issues.
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Paint light
and color

Create a light filled, 
atmospheric fantasy 

scene with this tutorial 
from Christoph Peters

plus
 • 10 of the best digital images
 • Paint like the Impressionists
 • Create a sleek interior
 • and much more!

http://www.2dartistmag.com
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Editor’s letter

Contributors
TOMI VÄISÄNEN
Tomi Väisänen  is from Helsinki, Finland, and creates 
3D art as a hobby and also as paid work. He’s currently 
working at Ubisoft RedLynx as a 3D generalist, and is a 
CGI enthusiast and self-titled nerd. 

RORY BJÖRKMAN
With a background in traditional art and sculpture, Rory 
Björkman is currently studying Media at the National 
College of Art and Design in Dublin, with a focus on 
digital arts.

VIKRANT J. DALAL
Vikrant Dalal has nearly a decade of experience in VFX 
and graphic design, which he’s ready to share with 
people who love VFX. He is based in India and runs 
Project01 Design Studio.

LEON ANTHONY ENRIQUEZ
Leon Enriquez is a 3D modeler, creature artist, digital 
sculptor and face shape artist. He’s currently working 
at Framestore in London, and has over a decade of 
experience in TV, video and animation.

VICTORIA PASSARIELLO
Victoria Passariello creates hard-surface models 
because she loves robots and 3D. She works at 
Perihelion Interactive making ships for sci-fi videogame 
The Mandate.

MARISA LEWIS
Junior Editor

KEEP UP TO DATE 
WITH 3DTOTAL!

• facebook.com/3dtotal
• facebook.com/layerpaint

• twitter.com/3dtotal
• twitter.com/layer_paint

• youtube.com/
3dtotalpublishing

• vimeo.com/3dtotal
• vimeo.com/layerpaint

• pinterest.com/3dtotal

• instagram.com/3dtotal

Thanks for picking up this final issue of 3dcreative! We 
wanted one more issue to wrap everything up and usher in 
the New Year, and we’re releasing it for free as a last thank-
you to you all for your readership and support.

This month we get to chat with Tomi Väisänen and Leon 
Enriquez, as well as learning about posing characters, 
sculpting animals, rendering spaceships, creating smoke 
effects, and more.

We hope you enjoy this issue and wish you all a happy, 
healthy and prosperous 2016 full of art and learning. Thanks 
for reading 3dcreative!

Welcome to 3dcreative issue 125!

STAVROS FYLLADITIS
Stavros Fylladitis is a 3D generalist based in Athens, 
Greece. He has worked for IXOR Visual FX and Faust VFX, 
and has a special interest in modeling and sculpting, 
proficient in software ranging from ZBrush to 3ds Max.

• google.com/+3dtotalcg

• 3dtotal.tumblr.com

ROUMEN FILIPOV
Roumen Filipov is a 3D generalist born in Bulgaria, 
currently living in Brazil. His specialty is making 3D 
characters for film and the advertising agency. Here, he 
sculpts a fun sci-fi character.
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Get the most out of it!

www.3dtotal.com
For lots more tutorials and exclusive articles, visit:

3dcreative magazine is available as a downloadable PDF magazine. If you have an iPad or iPhone, you can drag your 
magazine into your iTunes library – it will automatically add the PDF to your bookshelf in your iBooks app!

Junior Editor
Marisa Lewis
marisa@3dtotal.com

Sub-editor
Adam Smith

Graphic Designers
Matthew Lewis
Aryan Pishneshin

Advertising Manager
Kinnor Wroughton  
kinnor@3dtotal.com

Studio Manager
Simon Morse
simon@3dtotal.com

Managing Director
Tom Greenway

Advertising
Media pack and rates are 
available upon request. 
Contact Kinnor Wroughton : 
kinnor@3dtotal.com

International
Translation opportunities 
and international licenses are 
available. Contact Melanie 
Smith: melanie@3dtotal.com

Distribution
3dcreative is an 
e-magazine distributed as a 
downloadable PDF and on 
digital newsstands.

Disclaimer
All artwork, unless otherwise 
stated, is copyright ©2015 
3dtotal.com Ltd. Artwork that 
is not copyright 3dtotal.com 
Ltd is marked accordingly. 
Every effort has been made 
to locate the copyright 
holders of materials included 
in this issue of 3dcreative 
magazine in order to obtain 
permissions to publish them. 

Special thanks to 3DHype, 
Hiperia 3D and Veegraph for 
supporting 3dcreative with 
banners. Contact Kinnor 
Wroughton  if you would also 
like to show your support: 
kinnor@3dtotal.com

If you’re having problems viewing the double-page spreads that we feature within 
this magazine, then follow this handy little guide on how to set up your PDF reader!

Top tips for viewing
For optimum viewing of the magazine, it is recommended that you have the latest version of 
Adobe Acrobat Reader installed. You can download it for free here:

To view the many double-page spreads featured in 3dcreative magazine, you can set the reader 
to display “two-up”, which will show double-page spreads as one large landscape image:

Download resources
Whenever you see this symbol, be sure to click it to 
download free resources to accompany that article!

1. Open the magazine in Reader;
2. Go to the View menu, then Page Display;
3. Select Two Page Scrolling, making sure

that Show Cover Page in Two Page View
is also selected.

Visit http://www.3dcreativemag.com/resources_2015.html if viewing from a mobile device.

http://get.adobe.com/uk/reader/
http://www.3dcreativemag.com/resources_2015.html
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Each issue the 3dcreative team selects 10 of the best digital images from around the world. Enjoy!
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Obsidian Hauler
Josh Wilkinson

Year created: 2015
Software used: 

MODO, Quixel SUITE 2,
Unreal Engine 4, Photoshop
Web: JoshWilkinson3D.com

3DCREATIVE MAGAZINE   |  ISSUE 125

http://www.JoshWilkinson3D.com


Deep in the woods
Aron Kamolz
Year created: 2015
Software used: 
Vue, Photoshop
Web: artstation.com/artist/aronk
aronkamo.deviantart.com/

3DCREATIVEMAG.COM

https://www.artstation.com/artist/aronk
http://aronkamo.deviantart.com/
http://www.3dcreativemag.com
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Swamp Creature
Alessandro Baldasseroni
Year created: 2015
Software used: 
3ds Max, ZBrush, MARI, Photoshop
Web: artstation.com/artist/baldasseroni

https://www.artstation.com/artist/baldasseroni
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Sevres’ Gate
Clément Foucault
Year created: 2015
Software used: Blender, Cycles
Web: clement-foucault.com

3DCREATIVE MAGAZINE   |  Art Gallery

http://www.clement-foucault.com/
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Creatch
Damon Bard
Year created: 2015
Software used: 
ZBrush, KeyShot
Web: bardsculpturestudio.com/admin
damonbard.artstation.com

http://www.3dcreativemag.com
http://bardsculpturestudio.com/admin/
https://damonbard.artstation.com/
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Fox Tale
Ludovic Lieme
Year created: 2015
Software used: 
3ds Max, V-Ray, MARI, Ornatrix
Web: artstation.com/artist/ludoviclieme

http://www.3dcreativemag.com
https://www.artstation.com/artist/ludoviclieme
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Dragon Book
Ozani Ferreira
Year created: 2015
Software used: 
Maya, ZBrush, MARI and V-Ray
Web: ozaniferreiraart.com

http://www.3dcreativemag.com
http://www.ozaniferreiraart.com
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Alien Priest
Sebastián Montecinos
Year created: 2015
Software used: 
Maya, ZBrush, Photoshop,
Substance Designer, V-Ray, After Effects
Web: artstation.com/artist/postprocess

https://www.artstation.com/artist/postprocess


23

NOX 001 (Part 1 of 52)
Philip Harris-Genois

Year created: 2016
Software used: 

Mudbox, ZBrush, Softimage,
Arnold, Photoshop

Web: artstation.com/artist/pharrisgenois

https://www.artstation.com/artist/pharrisgenois


3DCREATIVEMAG.COM

Self Portrait
Jacques Leyreloup
Year created: 2015
Software used: 
Maya, ZBrush, Arnold, Yeti
Web: artstation.com/artist/rudrik

http://www.3dcreativemag.com
https://www.artstation.com/artist/rudrik


Immerse yourself into the world 
of VFX with Escape Studios, and 
bring your imagination to life.

Come and see what you can do

TURN YOU PASSION
INTO A CAREER

Image courtesy of Framestore

Pearsoncollegelondon.ac.uk/escapedegrees

http://www.3dtotal.com/offer/3dc125escapestudios
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3D generalist
Life as a 
We meet Ubisoft RedLynx’s Tomi Väisänen and 
learn more about his art and what makes him tick

http://www.3dcreativemag.com
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The Artist

Tomi Väisänen
3D Artist at Ubisoft RedLynx
 
tomivaisanen.com

Interviewed by:
Marisa Lewis 

Tomi Väisänen does 3D 
as a hobby and also as 
paid work. He’s currently 
working at Ubisoft RedLynx 
as a 3D artist.

http://www.tomivaisanen.com/
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Tomi Väisänen is a 3D generalist based in 
Finland, where he works at Ubisoft’s RedLynx 
company, with credits including platform 
racing game Trials Fusion.

3dcreative: Hi Tomi, thanks for talking to 
3dcreative! Please introduce yourself to our 
readers with a bit about who you are, where 
you’re based, and what you do.

Tomi Väisänen: Hi all. I’m Tomi, and I do 3D 
because I’m bad at drinking alcohol, unlike the 
rest of the Finns. I live in Finland, land of saunas, 
polar bears and mental disorders. It’s always dark 

outside and if we’re not depressed, we’re drunk! I 
was able to escape that fate by going deep inside 
my mind to pretend that I like doing art for a 
living. Eventually my hobby became a job. I used 
to work in the advertisement industry before I 
went to the game industry. Currently I work at 
Ubisoft RedLynx as a 3D artist.

3dc: What’s your creative background? How did 
you discover 3D?

TV: I was that kid who drew dinosaurs shooting 
lasers at each other and couldn’t care less about 
much more important things. A career in art was 

inevitable. Basically I used to draw a lot, edit 
videos, and did all sorts of motion-graphic things 
until I discovered that 3D was the correct tool for 
me. At first I thought that you need to be good 
at math to be able to produce 3D art, but how 
wrong I was. I can barely calculate with my fingers 
but that hasn’t stopped me from doing 3D.

Eventually I went to university to study 
multimedia production, which contained all 
the things I mentioned earlier, but the quality of 
teaching was horrible. Eventually I got a full-time 
job before graduating. I still haven’t graduated yet 
and don’t even have an interest to.

Hazmat Headgear – A personal piece created with 3ds Max, V-Ray and Photoshop

http://www.3dcreativemag.com


3DCREATIVE MAGAZINE   |  ISSUE 125

29

Heart of Eden – Personal work for a digital 
art exhibition in Helsinki, Finland
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TOP TIP 
Texture archive
Most of us carry some sort of digital camera with us nowadays, at least 
in our mobile phone. I’m constantly taking really random-looking 
pictures of different forms and textures, and use those as part of my 
works, whether it’s as a complete texture or just a reference image.

Kitbash library
Doing 3D is really time-consuming and modeling is slow. Make it faster 
by creating your own pre-made kitbash library and remember to 
update it now and then. Besides the geometry, save all the materials 
and textures you use. There’s no need to make the same thing twice.

Planetarium – Personal work made with 3ds 
Max, Corona Renderer and Photoshop

http://www.3dcreativemag.com
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Shells – Trying out a photorealistic style with 3ds Max and V-Ray
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http://www.3dcreativemag.com
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3dc: Who or what would you say are your biggest 
artistic inspirations?

TV: It’s really hard to say, because there are tons 
of really, exceptionally talented artists out there. 
Just looking at the front page of ArtStation makes 
me hate myself! I’m also really happy that I’m 
constantly surrounded by really talented people 
in my career.

3dc: What software or tools do you usually use?

TV: 3ds Max is the most common workhorse 
I use, as well as others like Photoshop, After 
Effects, and other common industry-standard 
tools. I’m constantly trying to learn new softwares 
and workflows. Currently I’m interested in 
photoscanning and learning how I could use that 
in my work.

3dc: Could you give us an idea of the typical 3D 
workflow you use?

TV: Yes, it’s a complete mess. When doing still 
images, I usually start with really fast and ugly 
photobashing and doing paintovers, just to get 
the ideas onto canvas. No one ever sees these 
fast sketches. After that, I start modeling from 
whatever seems to be a suitable starting point. 

Freightliner – Personal work made with 3ds 
Max, Corona Renderer and Photoshop

Precious Cargo – A personal piece created with 3ds Max, V-Ray, Fusion and Photoshop
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Usually it’s some minor detail that doesn’t even 
show on the final image..

After the modeling reaches a certain stage I 
start juggling the image between Photoshop 
and 3ds Max just to get a grip on what the final 
image might look like. After that, it’s just iteration 
after iteration until I hate it! The image is done 
when I’ve had enough. The final image looks 
good for about 10-15 minutes, but after that it’s 
just garbage, and I have this huge urge to start 
creating a new, better one – and that’s how you 
get better, eventually.

3dc: What’s one piece of advice you’d give to 
artists aspiring to work in the industry?

TV: Do more art instead of answering interviews 
like this! Do what you want, not what the others 
want. Have a passion for what you do, whatever 
it is. Post your work on forums and make 
connections to your fellow artists. And remember 
to eat broccoli.

3dc: What do you feel is your biggest 
achievement so far, in either your personal or 
professional work?

TV: I have won plenty of graphic competitions 
and short films in demoscene parties, which 
is always nice. But the biggest job I had was 
being responsible for directing the CGI trailer of 
Trials Fusion: Awesome Level Max for E3. It was 
something completely new, scary, but damn it 
was fun.

Marshland Sovereign – Created with 3ds Max, Mudbox, Fusion and Photoshop

Middle East Express – A tank design created with 3ds Max, Fusion and Photoshop

http://www.3dcreativemag.com
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3dc: What are you currently working on? Are there 
any new projects we should look out for soon?

TV: I wrote a tutorial describing my creative 
process which should come out soon. I’m busy 
with my daily job at Ubisoft RedLynx – it’s too bad 
I can’t mention anything because of NDAs. There’s 
always personal works in progress, of course.

3dc: Finally, what do you like to do in your spare 
time (if you have any)?

TV: There are a lot of computer games and 
movies involved in my spare time, just like in 
every nerd’s life, I guess. Of course it’s not a 
healthy habit, to sit in front of the monitor all day 
long creating art, so I like to keep myself at least 

in some sort of fitness. I’m also a really good chef, 
having mastered the skill of using too much chili 
in my food.

3dc: Thank you very much for speaking to 
3dcreative today!

TV: Thanks! It was a pleasure.

Bells & Whistles –
Tomi’s first-place entry 
for the Assembly 2014 
graphics competition

High Octane Rampage 
– Tomi’s winning entry 

in a 2015 graphics 
competition. It was made 

with 3ds Max, Corona 
Renderer and Photoshop



3DCREATIVEMAG.COM

3DCREATIVE MAGAZINE   |  Life as a 3D generalist

Wasteland Truck – One of a series of 
post-apocalyptic vehicle designs, made 
with 3ds Max, V-Ray and Photoshop

http://www.3dcreativemag.com
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The Artist

Tomi Väisänen
tomivaisanen.com

http://www.tomivaisanen.com/


   

* a  s e l e c t i o n  o f  o u r  a l u m n i ’ s  a c h i e v e m e n t s ,  c o n g r a t u l a t i o n s  t o  t h e m  a l l .

http://www.3dtotal.com/offer/3dc125lostboys


Start your journey to comic success and delve into 
the processes behind great comic art, learning 

the traditional and digital tools of the trade. 
From inking and coloring to anatomy and poses, 
you’ll discover everything there is to know about 
creating impressive characters for comic art. The 

comprehensive introductory chapters will show you 
how to choose the right tools for your work and help 

you to develop an understanding of the essential 
skills every aspiring comic artist needs.

ONLY 16.99 (APPROX 24.99)  |  208 PAGES
ISBN: 978-1-9094142-7-3

http://www.3dtotal.com/offer/3dc125comic_art
http://www.3dtotal.com/offer/2da_newsletter_signup_mag_ads
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Sketchbook of Damir G Martin 

Framestore’s Leon Enriquez tells us more about his 
ZBrush work, sculpting process, and finding time to sketch

The sketchbook of

Leon Enriquez

The Artist

Leon Anthony Enriquez
leonenriquez.wix.com/leonenriquez

Software used: ZBrush

Leon Enriquez is a 3D modeller, 
creature artist, digital sculptor 
and face shape artist. He’s 
currently working at Framestore 
in London.

http://www.3dcreativemag.com
http://leonenriquez.wix.com/leonenriquez
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Take a look through Leon 
Enriquez’ 3D sketchbook…

I usually do my sketches during my free time, 
and that is after work and after my 3-year-
old daughter falls asleep. If my production 
schedule permits, we sometimes do “lunch 
crunches”, which are about an hour of 
sculpting random topics during Friday at 
work. I like sculpting anatomy in particular, 
which is why I do my self-study and practice 
by sketching in 3D. It is the fastest and most 
effective way for me whenever I practice, 
as I get to see the whole form and concept 
from all angles. It’s like meditation for me as 
well, giving me the pleasure and privilege of 
freedom in my creativity. I am always critical 
of the form and flow during my studies and I 
always feel like there is not enough time for 
my sculpting appetite.

Inspiration and ideas
Even before I started sculpting anything, even 
traditionally, I was always in awe of the early FX 
industry, mainly monsters and odd creatures. 
There are just too many films that inspired me 
and it is unfair that I cannot mention them all, 
but Labyrinth, The Dark Crystal, and the Sinbad 
films were some that inspired me at a young age. 
Graphic novel and superhero characters also have 
a big influence on me creatively. The industry has 
mutated a lot nowadays, and there are tons of 
good artists out there to be inspired by.

Materials
For 3D sketching I use ZBrush, which has some 
useful and effective brushes like Clay Buildup, 
Morph, Move Topology and Snake Hook. Other 
very useful features like DynaMesh, ZRemesher 
and Group or Panel Loops help me speed up my 
workflow. Unfortunately I find the MatCaps and 
camera in ZBrush are unreliable, so I check my 
forms using KeyShot (which is very fun and easy 
to use) before I go ahead with working on the 
primary details.

Sketching workflow
In ZBrush I often start with a sphere instead of 
grabbing a pre-made generic man or anything. 
It’s just a personal thing, so I feel like the piece 
that I am working on was purely crafted by me. I 
often sculpt in parts, after all: the head, the torso 
and arms, and the pelvis to foot in the case of a 
normal two-armed biped. Then I just combine the 
parts and DynaMesh after the blocking is done. It 
depends on what I want to practice; sometimes I 
block in a T-pose, sometimes in a more dynamic 
pose. I’m not usually content with the first 
blocking, so I tend to do two or three before 
moving on to the primary forms. 

One of Leon’s lunch doodles from 2015
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A sculpt of a bounty hunter 
character, 2015

Delilah the were-hyena, a work in progress from 2015
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Leon’s version of the Wendigo. This sketch took four days in total, starting out as just a head sculpt
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: A sculpt of Pope Francis, 2014

A sketch of the writer J. L. Borges, 2014

A portrait of 
Einstein, 2014
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A likeness sculpt of actor Ed Harris, 2014

The Artist

Leon Anthony Enriquez
leonenriquez.wix.com/leonenriquez

http://leonenriquez.wix.com/leonenriquez


3 DT O TA L ’ S  A N AT O M I C A L  C O L L E C T I O N :
N E W  F I G U R E S  AVA I L A B L E  N O W

A f f o r d a b l e  a n a t o m i c a l  r e f e r e n c e  f i g u r e s  f o r 

t r a d i t i o n a l  a n d  d i g i t a l  a r t i s t s ,  i n c l u d i n g  m a l e  a n d 

f e m a l e  p l a n a r  m o d e l s  a n d  t h e  i m p r e s s i v e  b i o s u i t 

f i g u r e  d e s i g n e d  b y  A l e s s a n d r o  B a l d a s s e r o n i ! 

http://www.3dtotal.com/offer/3dc125anatomyfigures


O R I G I N A L  M A L E
A N D  F E M A L E

F I G U R E S  S T I L L
AVA I L A B L E  F R O M : 

S H O P. 3 D T O TA L . C O M

http://www.3dtotal.com/offer/3dc125anatomyfigures
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Posing a
character model
by Roumen Filipov
In this final stage of his workflow, Roumen Filipov uses the 
Super Simple Rig script and V-Ray to pose and render his 
fun steampunk character

The Artist

Roumen Filipov
roumenfilipov.com

Software Used:
3ds Max

Roumen Filipov is a 3D 
generalist born in Bulgaria, 
currently living in Brazil. 
His specialty is making 3D 
characters for film and the 
advertising agency.

Model, Maps &Texture files
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Roumen Filipov shows us how 
to bring characters to life with 
a simple pose…

This is the last of a series of four tutorials 
covering the production of a stylized 3D 
character – a steampunk pest exterminator 
girl – using ZBrush and 3ds Max, which was 
made since the initial blocking until the final 
render and post-production. In this fourth 
phase, we will learn how to achieve our 
desired hairstyle using 3ds Max’s native tools, 
and how to set up the render and lighting in 
V-Ray. Finally, I’ll mention some quick post-
production tips in Photoshop.

During the process, I’ll be showing how to 
use the Hair and Fur modifier in 3ds Max, 
taking different approaches depending on 
how the hair behaves, and also some render 
techniques with VRayHairMtl. This tutorial will 
also show how to properly pose and render 
your character, making it look interesting and 
with personality, even in front of a simple 
neutral background. I’ll also show how a 
simple light rig can achieve great results with 
a very small render time even for a 4k image, 
and what render elements and tricks I use to 
enhance the final look in Photoshop. In this 
project I also use Super Simple Rig script, 
freely provided by superrune on his website.

Now let’s have some fun!

01 Preparing the hair emitters: We have 
finished some good work on the look 

development of the character, but here comes the 
hard stuff: hair. I’ll use the Hair and Fur modifier 
along with VRayHairMtl to achieve the desired 
look, but first we need to prepare the mesh that 
will serve as a hair emitter. If we apply the Hair 
and Fur modifier to a very dense mesh, we will 
likely make 3ds Max crash immediately or, when 
it comes to combing, the number of guides will 
make your life a nightmare. 

First I paint the hair density mask as a black and 
white map inside ZBrush, then I apply it to a copy 
of the character’s head mesh and delete all the 
polygons that are displayed completely black. 
This avoids creating useless guides that would 
probably make the combing process difficult. I 
also detach some specific polygons that can be 
used to generate separated parts, such as the 
fringe of the hair.

02 Combing the hair: Now that our 
meshes and masks are ready, it’s time 

to begin hairstyling. Before we start, it’s good to 
import the sculpted mesh of the hair to use as 

a reference for the overall volume. The Hair and 
Fur modifier works by creating a guide for each 
vertex of the base mesh and then creating hair 
strands interpolated between these guides. There 
are two ways to manipulate the guides: you can 
model splines and use the ‘Recomb from splines’ 
option under the Tools rollout, or you can go to 
the Styling rollout and click the ‘Style Hair’ option 
to enable the styling brush. For this project, I use 

only the second option, and to make it easier, I 
divide the hair into a lot of different meshes with 
modifiers which I edit separately in order to find 
the perfect shape.

03 Rendering the hair: This step happens 
simultaneously with the previous step, 

due to the necessity of rendering the hair in order 
to have real feedback on the hairstyle. 

Hair emitter geometries and hair density masks

Combing process using Hair and Fur Modifier

VRayHairMtl settings 
and final render result

http://www.superrune.com/tools/supersimplerig.php
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First, you should look for the ‘mr Parameters’ 
tab in the Hair and Fur modifier and apply a 
VrayHairMtl in the slot. This material is made 
especially for hair rendering but can be applied 
to any geometry as well. You can customize how 
the hair looks by changing the colors of overall, 
diffuse, specular and transmission but I usually 
use the VRayHairInfoTex shader in order to 
change the behavior of the strands from root to 
tip. As an easy setup for realistic color variation, 
I use the ‘Hair&Fur/Alembic Color’ mode in the 
output; this makes the material use the built-in 
configurations of the Hair and Fur colors. As a 
final touch, you can play with the frizz, kink and 
flyaway settings in the modifier to get even better 
behavior of the hair.

04 Rig basic setup for posing: With all 
the look development done, we now 

need to pose the character. I usually prefer to 
do this using a simple rig solution inside 3ds 
Max. You can do it using the Biped system, CAT 
(Custom Animation Toolkit) or even custom rigs, 
but the best for me is the Super Simple Rig by 
superrune. It’s a free rig system and very fast to 
set up. All you need to do is open the rig-building 
tools, create the rig locators, move them to the 
positions of the body joints, and finally just click 
the ‘Build Rig’ button to create a fully functional 
rig ready for animation. The rig even has a similar 
parameters system to those you find in Maya 
controllers. It’s important that before you build 
the rig, you get the scale of the locators right 
in the rigging tools, this helps to create control 
shapes and bones in a good size to begin with.

05 Optimizing the rig: The Super Simple 
Rig is great but it don’t do all the work by 

itself – some minor adjustments must be done 
before skinning the model, especially if you use 
the Bones Pro plugin for it. First of all, there are 
some control shapes that are hard to select in the 
viewport, so you may want to scale them a little 
bit or even create new ones, attaching them to 
the originals and deleting the old shape inside 
the Edit Spline modifier.

Lastly we need to keep in mind that Bones Pro 
uses the bones’ size and shape to determine the 
initial vertex influence of each one, so go to the 
Animation tab in 3ds Max and open the ‘Bone 
Tools’ in order to change the size and add side 
fins. You can always add extra bones to the rig as 
well as controllers; all you need to do is link them 
to the original rig.

06 Skinning the character: The skin 
modifier inside 3ds Max is really messy 

and although you can get really nice results by 
painting weights, the initial distribution of bone 

influences is usually very bad. For this reason, 
I use the Bones Pro plugin, which replaces the 
Skin modifier with a much smoother and quicker 
workflow. If you apply the modifier and assign the 
bones, you’ll see that the result is almost perfect, 
especially if you adjusted the bones as shown in 
the previous step. After that, you can edit each 

bone influence by the falloff and strength, and if 
you would like to make some fine adjustments, 
there is a weight-painting tool as well. 

You can convert to a standard skin modifier with 
one click inside the Bones Pro preferences and 
the skinning will still behave the same way.

Rig locators and full rig built from them

Extra control shapes and resized bones

http://www.3dcreativemag.com
http://www.superrune.com/tools/supersimplerig.php
http://www.superrune.com/tools/supersimplerig.php
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Bone influence and settings in Bones Pro
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07 Posing the character: Now that we 
have finished all the hard work, it’s time 

to put the rig in action. Posing the character with 
a nice and functional rig is often very easy and 
lets you test many poses, but you need to have 
in mind some concepts of body mechanics and 
follow some composition rules if you want to 
get a nice result. She is a strong and competent 
girl that has to fight with some big bugs in her 
everyday job, so I choose to put her in a confident 
pose, but still showing that holding all that heavy 
gear is not an easy task. To make the final image 
more interesting, I look at slightly reinforced line 
of action, but also use some straight lines to help 
guide the eye towards her. Some things I have to 
model just for the pose, like the hose connecting 
the tank and the spray gun.

08 Lighting setup: Lighting is something 
that can give life to the image, or kill 

it. I see a lot of renders of incredible models on 
the internet, but sometimes they are completely 
ruined due the fact that the lights and exposure 
are not doing the job. Always think of how you 
want a surface to behave in the render: for 
example, a metallic object may look completely 
bright if you use a light that’s too large for the 
specular you want. 

For this character, I use a simple three-point 
lighting setup, which consists of a key light with 
slightly sharp shadows, a big and strong backlight 
to make the character pop in front of the dark 
background, and a fill light just to lift the black 
areas. I always use V-Ray Exposure Control in 
the Environment tab so that my renders are not 
dependent on the settings of the physical camera.

09 Render setup: What I love about 
V-Ray is definitely its speed and ability 

to render nice and smooth images without 
pushing the hardware too far. Keep an eye for low 
reflection/refraction samples on the materials 
and samples in VRayLights. These can add a 
lot of noise to the render and actually make it 
slower. You should always have a VraySampleRate 
element selected so you can monitor where the 
DMC sampler is having trouble.

For primary and secondary GI solutions, I use 
Irradiance and Light Cache with simple presets, 
but you can get smooth results with even lower 
settings. The ‘Embree’ option really speeds up 
the render with no quality loss, especially for 
hair, but always remember to set your dynamic 
memory high enough. Lastly, the render elements 
I use are just some basic ones like reflection, 
refraction, VrayExtraTex with a VRayDirt map for 
the occlusion, and some masks for easy selection 
of different parts of the body in Photoshop.

10 Post-production: Render your images 
in at least 16-bit TIFF format if you want 

to have good control over color and brightness. I 
usually do the post-production by using the extra 
elements to increment my beauty pass.

For this project, I start by adding the ambient 
occlusion element as a Multiply layer over the 
beauty pass. This will increase the overall contact 
area within the image, and cover some light leaks 
in the model. 

Planning of the character’s pose

Three-point lighting and exposure settings

http://www.3dcreativemag.com
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After this, I play with local specular and reflection 
elements to increase and even change the color 
and intensity of the metallic objects. I add some 

adjustment layers to correct some colors and 
values, like Color Balance, Curves and Levels. You 
can add some subtle effects like lens dirt and 

chromatic aberration, but always take care to not 
add too much distraction around your subject, 
the character.

V-Ray render settings

Post-production in Photoshop
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TOP TIP 
Super Simple Rig
You can find all you need to know 
about the rig I used in the tutorial 
at this link. It’s totally free, and at 
the bottom of the page you can 
find instructions about installation, 
building the rig and animating with it. 
You will also need the Pen Attribute 
Holder modifier from this link.

http://www.3dcreativemag.com
http://www.roumenfilipov.com
http://www.superrune.com/tools/supersimplerig.php
http://penproductions.ca/scripts/penAttributeHolder/penAttributeHolder.htm%20
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Rendering a
spacecraft scene
by Victoria Passariello
Learn how Victoria Passariello uses Marmoset Toolbag 2 and 
Photoshop to add the final touches to her impressive spaceship

http://www.3dcreativemag.com
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The Artist

Victoria Passariello
vitrux3d.com

Software Used:
3ds Max 

Victoria Passariello 
creates hard-surface 
models because she loves 
robots and 3D. She works 
at Perihelion Interactive 
making ships for sci-fi 
videogame The Mandate.

http://www.vitrux3d.com
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Pick up some useful post-
production techniques from 
Victoria Passariello…

In this, the last article of the series, we’re 
going to cover creating an environment for 
our ship, and modeling a hangar with simple 
elements. Then we’ll set up the final render 
in Marmoset Toolbag 2, adding secondary 
sky lights on the HDR to obtain nice specular 
reflections on the ship and interesting 
shadows on the floor, as well as adding fog 
and depth of field to make a more realistic 
scene. Finally we’ll cover every layering step in 
Photoshop for the post-production of the final 
image, from the addition of dust, smoke and 
other effects, to the final adjustments in terms 
of contrast and color balance to give more 
drama to the image.

01 Modeling the environment: For 
the final image I need to create an 

environment for the ship. In the original concept, 
the ship was located in a space hangar. Inside 3ds 
Max, I model every single object that composes 
the hangar: the floor, wall, roof, tubes, cables, 
metal structures and so on. I place a camera and 
start to build the scene as similarly as possible 
as the concept. I use very simple meshes for 
the elements of the environment. Most of them 
will be very blurred in the final image due to 
the camera’s depth of field, so I don’t make any 
detail on them, only adding little chamfers on the 
borders. Keep in mind that the ship is very big, so 
be careful with the proportions of the elements. 
Focus on the elements you can see in the image; 
it’s not necessary to model a complete hangar as 

Simple models are made in 3ds Max for all the elements of the hangar

Creating all the materials for the hangar, and setting up the HDRI in Marmoset Toolbag 2

Add sky lights in specific areas of the HDRI to obtain nice specular reflections on the ship and nice cast of shadows on the floor

http://www.3dcreativemag.com
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long as the final image looks correct and good. 
I don’t make any UVs for these elements – I only 
apply a UV map modifier.

02 Scene setup in Marmoset Toolbag 
2: Inside 3ds Max, I organize all the 

elements in different layers and export them in 
groups; for example, all the element of the wall, 
the elements of the floor, all the tubes, cables, 
and so on. This way it’s going to be easy to 
manipulate them in Marmoset Toolbag 2.

I import all the OBJ files into Marmoset Toolbag 
2 and start to create different materials for them. 
I don’t use any textures, only playing with the 
glossiness, albedo and metallic values for each 
material. I only used a simple concrete map for 
the wall and floor materials. Notice that I don’t 
add too much reflection to the materials because 
I want to be faithful to the style of the concept 
and keep all the elements dark.

After this, I start to play with different HDRIs, 
choosing ‘Castle Sunset’. I also set up the camera 
with a 33mm focal length and add a flare effect.

03 Adding secondary lights: Once I have 
the scene with the selected HDRI and 

all the materials applied to each element, I start 
to add more sky lights around specific areas to 
obtain nice shadows on the floor, visual interest 
points and the main focus on the middle-back 
area of the ship. Before starting to add the lights, 
I check the ‘Local reflections’ and ‘Ambient 
occlusion’ options under the Render tab.

In the image you can see each light I create, 
adding them one by one (I’ve marked them with 
a green arrow) so you can see the progress in the 
illumination. When you add a sky light into the 
Light Editor, it automatically assigns a color to 
that light depending on its position on the HDR 
map. I didn’t change any colors, but kept all the 
lights with their default color. After this I also add 
a subtle bloom effect.

04 Adding depth of field and fog: With 
all the illumination done, it’s time to 

activate the depth of field to give the image a 
more realistic feeling. I play a bit with the near 
blur, far blur and bokeh size, trying to find a 
balance where nothing looks too blurred, with a 
nice and smooth transition from the focal point 
(the ship) to the very back.

At this point the image looks quite good but it’s 
missing some atmosphere, so I add a fog effect. 
The fog is very useful to separate the elements 
in the foreground and background, and again it 
gives a very realistic feeling to the scene.

05 Layering different exposures: At this 
point I’ve finished the scene’s 3D stage, 

so let’s go to Photoshop to post-produce the final 
image. I use Marmoset Toolbag 2 to render out 
three images at different exposures: 1, 2 and 0.3.

The base image in Photoshop is the one at 
exposure 1. This image has very flat colors, 
with everything looking too homogeneous; I 

want to add some more contrast and a more 
dramatic feeling to it, and to do so I use the 
image at exposure 2 (at around 30% Color Dodge 
blending mode) to mask the lightest of the areas; 
and the image at exposure 0.3 (in Soft Light 
blending mode) to mask the darkest of areas. 
Using this technique here, I can therefore start 
creating some Vignette effects but with the real 
illumination of the scene.

Activate the depth of field in the camera and create some fog to add more atmosphere and realism

Render out three different exposures and layer them in Photoshop with masks to add more contrast
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06 Adding dust particles: I search over the 
internet for dust particle images and test 

a few of them. I finally choose one with very small 
particles, remembering to always be consistent 
with the proportions of the elements, even with 
the dust. The inside of the hangar is a huge place 
and the small dust particles will help to create 
that sensation. I use the image in 60% Color 
Dodge blending mode.

07 Adding smoke: For the smoke I use an 
image from textures.com. 

In Photoshop I select the white areas of the 
smoke with Color Range to get rid of the blue 
background. I make several duplications of it and 
put them around the image, always rotating and 
flipping them to avoid any evident repetitions, 
and masking some regions to hide or show 
different areas of the smoke. 

I usually use them in Pin Light blending mode 
at low opacity, but this depends on the result 
you want to achieve. Previously in Marmoset 
Toolbag 2, I rendered an image with a transparent 
background to use as a mask for the smoke, 
turning off all the elements except the ones in the 
foreground (ship, tubes, cables, and so on.). 

I use this image to create a mask in the smoke 
folder, so these elements will be in front of the 
smoke. You can always manually paint out any 
areas of the mask as you wish, to bring the smoke 
to the front or back.

08 Lens flare effect: I always like to add 
some lens flare effects in the shiniest 

areas of the image, to give a really nice sci-fi look. 

Be careful to not add too many, otherwise they 
will look too redundant. Just choose some areas 
to place them as a final detail in the image – 
usually one or two is enough. This time I choose 
a lens flare image from the psdbox and use it in 

Screen blending mode; one in the main cabin to 
help the focal point and the second in one of the 
roof lights. Another detail I add to the image is 
some small dots with a simple brush to suggest 
some lights; again, two or three is more than 
enough here.

09 Adding texture to the wall: The wall on 
the left looks too flat, so I add a texture 

to it to make it look better. This time I use an 
image from ‘Total Textures V07:R2 – Sci-fi’. First of 
all I play with the arrows of the blending options 
inside the Layer Style window. This way I remove 

Adding a very subtle dust particle effect in Color Dodge blending mode Use an image of smoke or clouds to add some smoke to the image. You can 
separate the white smoke from the background using Color Range selection

Adding lens flare effects to the image is a 
very nice detail, but don’t abuse it!

I add a texture to the left wall. Keep the darkest areas by modifying the blending options

http://www.3dcreativemag.com
http://textures.com
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some of the lightest areas of the image. I apply 
the image in Overlay blending mode and make a 
duplication set to 50% Multiply to intensify it a bit. 
I also paint a mask over the region of the wall, and 
finally I add a small decal in the corner of the wall.

10 Adjusting Curves and Levels: The final 
step to complete the post-production 

is to add even more contrast and drama to the 
image. To do so, I make some adjustments to the 
Curves, Levels and Color Balance.

Once you’ve finished all your adjustments, you 
can make a copy of the merged image and add a 
bit of Sharpen filter (at around 30-40%) to make 
it look more defined. At this point we can say the 
image is done!

TOP TIP 
The Sharpen filter
and Smudge brush
At the end of the composition, 
applying a Sharpen filter to the 
image will make it look clearer. 
Don’t use it at 100% or it will 
look extremely sharp (I usually 
use it at 30%-40%). Once you’ve 
applied the Sharpen filter, you 
may encounter some specific 
high-contrast areas that have 
unwanted jagged lines. This 
inconvenience is very easy to 
fix – just use the Smudge brush 
in a very small size and pass it 
in one direction to smooth over 
the jagged edges and the neck.

Use the Smudge brush to smooth the resulting jagged lines after applying a Sharpen filter

To finalize the image, make some adjustments in the Curves, Levels and Color Balance to add more contrast and drama
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The Artist

Victoria Passariello
vitrux3d.com
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Sci-fi ships in
mental ray
by Rory Björkman
Rory Björkman guides us through rendering a steampunk ship in 
mental ray for Maya and compositing the final image in Photoshop

Ship assets and backgrounds

http://www.3dcreativemag.com
http://www.3dcreativemag.com/tutorial_resources/issue_125_jan_2016/tutorial02b.zip
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The Artist

Rory Björkman
artstation.com/artist/bjorkman

Software Used:
Maya, MARI

With a background in traditional 
art and sculpture, Rory Björkman 
is currently studying Media at the 
National College of Art and Design in 
Dublin, with a focus on digital arts.
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Get your sci-fi vehicles 
shipshape with Rory 
Björkman’s assistance…

In this section of the tutorial, we’ll be looking 
at how to render and finish our sci-fi airship 
model using mental ray and Photoshop.

01 Scene setup: First let’s start by opening 
the scene ‘airship.MA’, or import your 

own model if you’d prefer to use that. In the 
Windows menu, access Settings and Preferences, 
then open the Plug-in Manager. In here, enable 
the ‘mayatomr.bundle’. Next, under the Display 
Render Settings tab, we need to enable mental 
ray. In this tab, under Common, scroll down to 
Render Options and uncheck the Enable Default 
Light box.

02 Preparing the background image: 
When choosing a background image, 

it’s important that our airship will fit into it 
compositionally. In order to create more width 
and landscape, we can easily widen the image in 
Photoshop with the Crop tool. In the assets folder 
you’ll also find a tower. Place the tower on top 
of the image and flip it horizontally. By adjusting 
the color settings, you can off-set the colors to 
add more of a blue tint to it until you’re happy 
it matches the environment of the background 
image. Save and close.

03 Importing our background image: 
To import the background image, we 

first need to access the camera settings. Under 
the Environment tab, press Create and plug in 
our prepared background image. At present our 
image will cover the ship, so in order to offset it 
behind the ship, we can adjust the depth under 
the Placement settings. Finally, let’s select the 
Image Plane in the viewport and assign it to a 
new layer. This way we can view or hide it easily.

04 Material overview: For this project 
we shall use the Mia_Material_x. To 

understand how this works, I have laid out 
a quick illustration of the parameters of this 
material. In the Color node we can place our 
Diffuse textures. In the Reflection Color we can 
tint the Glossiness output. It’s important to note 
that the grayscale maps in Color will also drive 
the Reflection output, where black is matte and 
white is shiny. This is the same for the Reflectivity, 
where I’ve plugged in a black-and-white checker 
to demonstrate the difference. The gloss works 
the same way, where black will drive a noisier 
output to super shiny glaze. Finally we can make 
chromium or metallic finishes by adjusting the 
BRDF in a similar manner, where black with full 
gloss creates a perfect mirror.

Open airship.MA or import your own model

Enabling mental ray for Maya

Preparing the background image in Photoshop

http://www.3dcreativemag.com
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An overview of mental ray’s materials

Importing the background 
image we made previously
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TOP TIP 
Using realistic scale
mental ray materials and most physically based rendering 
engine materials work best when the object being rendered 
is real scale or close. This is because mental ray uses 
algorithms which are generated by real-world physics like 
reflectivity and attenuation. I usually start by opening the 
Maya Preferences, then settings and change the value from 
Centimeters to Feet. Next under the Create menu, access 
the Measure Tool and then Distance Tool. By plotting two 
points from tip to tip you can scale your vehicle as close to 
real size. 

Note: when you scale a large object, it may be clipped out 
of the scene by the camera. To rectify this, open the camera 
settings and increase the Far Clip Plane by adding one 0; 
in some cases, setting the Near Clip Plane to a value of 1 is 
also good.

Rescale the ship to the correct size

Applying materials to the ship

http://www.3dcreativemag.com
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05 Applying materials: All of the metals on 
the body are applied in the same manner 

as above. For the normal map, open up the Bump 
node and plug the normal map into the Standard 
Bump node. 

When this node opens, select Tangent Space 
Normals. You can preview materials in the 

viewport by pressing 6. Press 5 to revert back to 
the smooth shaded mode. Apply the main body 
diffuse to the Color tab and the Reflection Color 
tab. The specular map can then be used in both 
the Reflective node and the Glossiness node. 
Also, input the specular map to the ‘0 Degree 
Reflection’. Remember to enable the ‘Alpha is 
Luminance’ option.

06 Applying the glass material: The glass 
material is different to the metal in that 

we do not apply a map to the BDRF. First apply 
your specular map to the glossiness, and leave 
the reflectivity at a standard. The diffuse can be 
plugged into the reflective color if you wish. Lastly 
apply our diffuse map to the color tab. As well 
as using the 6 key to see textures in real time, it 

TOP TIP 
Alpha is Luminance
It is very important when using 
grayscale maps/images to drive 
the reflectivity, gloss or BRDF 
that ‘Alpha is Luminance’ is 
enabled. Also, if you find that 
your maps are not quite giving 
to the desired strength output, 
adjust the Alpha Gain slider 
under Color Balance to brighten 
or darken the maps’ output 
and affecting the selected 
node (e.g. gloss, reflectivity, 
etc.) Increasing the Alpha will 
intensify shine and decreasing it 
will produce matte finishes.

Don’t forget to enable ‘Alpha is Luminance’

Applying the glass material works slightly differently
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Creating a physical sun and adjusting its direction

Creating an IBL sphere
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may be a good idea to make some quick preview 
renders as you go, using a basic physical sky light 
under the Scene menu in the Render Settings 
Window.

07 Lighting setup: First create a physical 
sun and use the scale to enlarge the sun 

direction arrows. Then rotate the sun direction 
of the shadows on the background image. Next 
create an image-based light sphere and import 
an HDR image to this. I will use the glacier.HDR 
supplied. The HDR intensity can also be tuned 
with the alpha color settings in the HDR plug-in 
menu, but usually the standard setting is apt.

08 mental ray portal lights: mental 
ray portal lights are powered by the 

environment IBL we plugged in earlier. The 
difference is that we can now more accurately 
boost the IBL in certain places using the portal 

TOP TIP 
Leave the diffuse map for last
A good way to ensure that 
the specular and gloss values 
(as well as the normal maps) 
are applied correctly and the 
desired result will be achieved, 
is to not apply the diffuse map 
until last. This way you can 
clearly see how well the maps 
are working, as the diffuse color 
can often make errors much 
harder to see. Remember you 
can adjust map intensity by 
adjusting the Alpha color in the 
Color attributes of the map file.

Creating a standard area light

Creating two test spheres and applying a chrome material

Applying the diffuse map too soon can distract from errors
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lights. To create a portal light, we must first create 
a standard area light, scale it up and point in 
the direction of our airship. Under the Custom 
Shaders menu in the area light’s attributes, select 
the Light Shader tab and input a mia_portal_
light. If you wish to increase or decrease the 
intensity, this can be done by manipulating the 
Intensity Multiplier.

09 Optional: Geometry as a light 
source: This is an optional method for 

creating a light source. I’ve set up a quick little 
scene to demonstrate. By selecting any piece of 
geometry and assigning a new mia_material, 
we can then assign a mia_light_surface node 
to the additional color under the Advanced tab. 
In order for the lit object to disperse light to 
surrounding geometry, we first need to bump up 
the fg_contribution under the Parameters tab. 
The higher the fg_contribution, the more the light 
will spread. To eliminate blotchy light gradients, 
open the Render Settings window and enable 
Final Gather. By increasing the accuracy and point 
interpolation, you will improve the quality but 
increase render times.

10 Optional: Spot lights: In conjunction 
with object lights, spot lights can be used 

to cheat object light direction. By setting the fg_
contribution value to 0 in the object light settings. 
We can then place a spot light in the scene. A 
great way to see where your spot light is shining 
is to select it, and then under the Panels menu in 
the viewport, select ‘Look Through Selected’. This 
way the spot light acts as a temporary camera 
enabling you to accurately place its path of 
projection.

11 Final render settings: Now we are 
ready to render our final image. Let’s first 

select the mentalrayIbl (IBL sphere) and turn off 
its primary visibility in the attribute editor. This 
can be found under the mentalrayIblShape1 
Render Stats tab. Next make sure your 
background image is also turned off. In the 
Render Settings window, set the file type to PNG 
or TIF, whichever you prefer. Set the image size 
you desire and make sure Final Gather is enabled 
under the quality settings. This will be in the 
legacy options.

12 Adding steam in Photoshop: If we 
bring our final render into Photoshop 

and place it on front of our background image, 
we may need to slightly tweak the import or 
background to fine tune blend the color. This can 
be done using the Color Balance under the Image 
> Adjustments menu. I’ve also supplied a steam.
psd which you can use to add some life to the 
scene. But decreasing the exposure value and 

Creating a mia_portal_light

Creating directional 
light using spot lights

Creating a light source using geometry
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opacity of this layer we can help blend it to look more like a dark smoke in 
the sky.

13 Quick iterations: It’s very easy to completely change our scene 
because once you change the IBL image it will also drive the color 

from the portal lights. By rotating the IBL and the sun, we can drop an array 
of images behind our ship and match the lighting pretty quickly. There are 
also tons of free Photoshop plug-ins and free background images online to 
use . For free filters, many good ones can be found here and lots of beautiful 
background images can be found on www.textures.com. Go have fun!

The airship with windows being used as object light emitters and spot lights

Our render settings Adding steam effects with Photoshop

http://www.creativebloq.com/photoshop/photoshop-actions-912784
http://www.textures.com
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Importing the background image we made previously
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TOP TIP 
Testing on neutral materials
As for materials, it’s a good idea to test your light on color-neutral objects. By inserting two spheres into our scene and applying a standard mia_
material_x to one and a mia material_x preset of chrome to the other, we can get a good representation of light shadow and intensity as well as 
atmospheric hue. To go a step further you can even apply a flat gray to your vehicle to check for shadow lines. Import different HDR images to test 
the outcome.

Testing HDR lighting on neutral-colored materials
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Realistic smoke
in FumeFX
by Vikrant J. Dalal
Vikrant Dalal takes a look at the powerful FumeFX plugin for 3ds 
Max and how it can be used to create a lifelike smoke effect

The Artist

Vikrant J. Dalal
project01studio.blogspot.com

Software Used:
3ds Max

Vikrant Dalal has nearly a 
decade of experience in VFX 
and graphic design, which he’s 
ready to share with people 
who love VFX. He is based 
in India and runs Project01 
Design Studio.

Scene & Video files
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Try your hand at FumeFX with 
Vikrant Dalal’s guidance…

Hello everyone! In this tutorial we are going 
to take a look at how you can use FumeFX for 
3ds Max to make a thin white smoke effect 
which could be used for candles, matchsticks, 
cigarettes, incense, and so on. To start, I will 
introduce the idea of thin smoke, which you 
may have seen many times in your daily life. 

There are number of software packages 
and plugins with which you can create fire 
and smoke effects, such as FumeFX and 
Phoenix FD for 3ds Max and Maya, Houdini, 
Cinema 4D, but many big VFX and animation 
studios use FumeFX in their pipeline as it’s 
well-established, trustworthy and most 
importantly user-friendly. 

There are different techniques you can use to 
make this effect in FumeFX, such as Simple 
Source, Object Source and Particle Source, but 
we are going to use Object Source.

Before you start working on this kind of effect, 
it helps to have good knowledge of smoke 
properties, such as Turbulence, Velocity and 
Buoyancy. There are different types of smoke, 
from thin smoke for incense and cigarettes, to 
thick oil smoke or explosion smoke, and each 
one has different properties.

I can’t teach you each and every parameter 
of this plugin and software, as they’re very 
vast and need a lot of time to go through, but 
this particular tutorial will cover as much as 
required to create this thin smoke effect. This 
is a very interesting subject, because you can’t 
define one certain process to create this effect. 
As much as you will use your creativity and 
tools, you will find different types of effects 
every time. So it very much depends on your 
own understanding of using the different tools 
and techniques.

01 Create and modify object: Open 3ds 
Max. Before we start working on our 

scene, remember that we are going to use the 
Object Source technique in FumeFX. This means 
we are going to use an object to emit smoke, so 
for that purpose we’ll start by creating an object 
(in this case, a GeoSphere).

Go to the Create panel and select Geometry > 
Standard Primitives > GeoSphere. Now change 
the Radius to 2 and Segments to 2, and set the 
Position to X: 00, Y: 00 and Z: 5.75. Then convert 
this GeoSphere into an Editable Poly and modify 
it as shown in the image.

02 Create a FumeFX Object Source: After 
finishing the modeling of our object, it’s 

time to proceed to the FumeFX plugin. So first of 
all we will create the FumeFX Object Source where 
we will add our Object. To create a FumeFX Object 
Source, go to Create Panel > Helpers > FumeFX > 
Object Src. Click on this button and drag it into 
the viewport. Now go to the Modify panel to make 

some changes in the Parameters. Change the 
Object Src Type to Solid. Set the Temperature: 
600.0, Smoke: 20.0 and keep the other parameters 
as they are.

03 Create a FumeFX Container: We 
are going to use FumeFX here, as it’s 

very simple, but still has many options and 

Creating an object to emit smoke

The FumeFX Object Source

Creating a FumeFX Container



3DCREATIVEMAG.COM

3DCREATIVE MAGAZINE   |  Realistic smoke in FumeFX

parameters. We’ll cover as much as is required for 
this particular tutorial.

So let’s start with the FumeFX Container. Go to 
the Create panel and select Geometry > FumeFX > 
FumeFX. Click on the FumeFX button and drag it 
into the viewport, then go to the Modify panel and 
set the Size and Spacing as follows. Width: 200, 
Length: 200, Height: 300 and Spacing: 0.75.

Now set the Position of FumeFX to the following: 
X: 00, Y: 00, Z: 00.

04 Modify the FumeFX Container: After 
setting up the FumeFX Container, it’s time 

to modify the parameters. So select the Container 
and go to the Modify panel. Now click on the 
‘Open FumeFX’ UI button and a new window will 
appear. As you can see, there are six sections in 

this FumeFX interface and we will modify them 
one by one. So let’s start with the Obj/Src section. 
In this section you just have to add the FumeFX 
Object Source which we generated earlier. So go 
to the Obj/Src section and click on the Pick Object 
button, then select the FumeFX Object Source.

05 FumeFX – General Parameters: After 
finishing the setup of the Obj/Src section, 

Modifying the FumeFX Container

Going through FumeFX’s General Parameters section Setting up FumeFX’s Simulation section
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let’s set up the General Parameters section. 
We have already the set General Parameters to 
Spacing: 0.75, Width: 200, Length: 200 and Height: 
300. Now we’ll move ahead to the Output Range, 
set the Start Frame: 0, End Frame: 400, then go 
to Paths, where we set the FXD Files (Cache Files) 
path. So click on the button which is next to the 
Default Path and set the path as per your Folder 
Structure. Now move ahead to Playback Range & 
set the Play From: 0 & Play To: 400. So these are 
simple modifications in General Section.

06 FumeFX – Simulation: After finishing 
the setup of General Parameters, 

let’s modify the Simulation section. Go to the 
Simulation tab and apply the following settings:

-  Time Scale to 1.5 to increase the overall 
speed of scene

- Gravity to 2.5
-  Vorticity to 0.0 to reduce the internal motion 

in the smoke
- X Turbulence to 0.1

Now go to Turbulence Noise and set the Scale 
to 60.0, Frames to 10.0 and Details to 1.0. Go to 
Fuel and turn it off, because we don’t need fuel 
or fire to emit smoke; this way we can reduce 
the simulation time. Then go to Smoke and set 
‘Dissipation Min. Dens.’ to 0.1 and Dissipation 
Strength to 1.0 to dissipate the smoke fast. Keep 
the other parameters as they are and hit the 
Simulation button. It will take around 2-3 hours 
to finish.

07 FumeFX – Rendering: After finishing 
the simulation, just make sure that 

everything is as per your requirements. Now 
let’s make some simple modifications, starting 
with setting the color of the smoke. Go to the 
Rendering section and then Smoke parameters. 
Set the smoke color to gray, then turn on the Cast 
Shadows and Receive Shadows options, so we’ll 
see the smoke’s shadow when we add light.

08 FumeFX – Illumination: After finishing 
the Color settings, it’s time to add light 

to the scene. Go to the Create panel and select 
Lights > Standard > Target Spot. Click on Target 
Spot light and create in viewport. Now set the 
light position to X: -800, Y: -400, Z: 720. Set its 
Target Position to X: 0.0, Y: 0.0, Z: 80.0. Now select 
the light, go to the Modify Panel, turn on the 
shadow and set it to Ray Traced Shadows. Then 
go to the Shadow Parameters and turn on the 
Atmosphere Shadows. When you’re done with 
these settings, return to the FumeFX Container, 
then go to the Illumination section, and add this 
light into the Lights section by clicking the ‘Pick 
light’ button.

09 Rendering and post-process: After 
finishing the light setup, now it’s time 

for rendering. Go to Render Setup, set an Output 
Range, Output Resolution and Output Path, then 
hit the Render button. It will take around two 
hours to finish the rendering.

Afterwards, you can import all the renders into 
After Effects, or any compositing software which 
is convenient for you, and make some changes in 
the color or brightness of the image, then render 
out the final output. And now you will have some 
thin smoke!

Selecting a color for the smoke

Adding light to our smoke effect

The render settings for the final smoke effect
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CHECKOUT CHAPTER 02
ON PAGE 086

Creating dramatic
smoke effects…

TOP TIP 
Try Simple Source and Particle Source
We have achieved this effect using FumeFX’s Object 
Source technique, but you can also try Simple 
Source and Particle Source. Simple Source doesn’t 
need any object to emit smoke – it has its own 
simple shapes, like Sphere, Cube and Cylinder. But 
if you want to work with Particle Source, then you 
should have at least basic knowledge of 3ds Max 
Particles. It’s totally fun to try different things.

Try to create a live action shot
Always try to shoot real footage and then add your 
CG work into that footage to make complete shot. 
This way you will learn about camera tracking, 
lighting and compositing too. 

Always watch references
Always watch real examples for a better 
understanding. It helps a lot to know the behavior 
and appearance of smoke, and its interaction with 
solid objects or with wind. You should use this tip 
for other things as well. I suggest doing maximum 
‘research and development’, so good luck!

Use different parameters
As you can see, there are many parameters in 
FumeFX. You should try different parameters and 
simulate the scene, so you get a feel for the specific 
use of parameters and how they work, specially 
Turbulence and its scale, then Vorticity and Velocity 
Damping. Try creating the smoke using Fuel, or you 
can use Wind Force as well to make it more realistic.
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Create dramatic
smoke effects
by Vikrant J. Dalal
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about something bigger? Vikrant Dalal shows how to make 
billowing black smoke in FumeFX for 3ds Max
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Join Vikrant Dalal as he shares 
his FumeFX expertise…

Hello everyone! Here I’ve got a tutorial for 
creating a thick smoke effect, which can be 
used for such things as oil or explosion smoke, 
a volcanic eruption, a forest fire, and so on. 
You may have seen this kind of smoke on the 
internet or on television, or sometimes in your 
real life, but it doesn’t happen every time.

There are number of software packages and 
plugins with which you can create fire and 
smoke effects, such as FumeFX and Phoenix 
FD for 3ds Max and Maya, Houdini, Cinema 4D 
and so on, but many big VFX and animation 
studios use FumeFX in their pipeline as it’s 
well-established, trustworthy and most 
importantly user-friendly. There are different 
techniques you can use to make this effect in 
FumeFX, such as Simple Source, Object Source 
and Particle Source, but we are going to use 
Object Source.

Before you start working on this kind of 
effect, it helps to have good knowledge of fire 
and smoke properties, such as Turbulence, 
Velocity and Buoyancy. There are different 
types of smoke, from thin smoke for incense 
and cigarettes, to thick oil smoke or explosion 
smoke, and each one has different properties.

I can’t teach you each and every parameter 
of this plugin and software, as they’re very 
vast and need a lot of time to go through, but 
this particular tutorial will cover as much as 
required to create this thick smoke effect. This 
is very interesting subject, because you can’t 
define one certain process to create this effect. 
As much as you will use your creativity and 
tools available, you will find different types of 
effects every time. So it very much depends 
on your own understanding of how to use the 
tools and techniques.

01 Create an object: Open 3ds Max. 
Before we start working on our scene, 

remember that we are going to use the Object 

Source technique in FumeFX. This means we are 
going to use an object to emit smoke, so for that 
purpose we’ll start by creating an object. We’ll use 
a Plane.

Go to the Create panel and select Geometry > 
Standard Primitives > Plane. Now change the 
parameters to the following: Length: 40, Width: 40, 
Length Segments: 50, and Width Segments: 50. 
Set the Position to X: 90, Y: 00 and Z: 15.

02 Modify the object: After creating the 
Plane, it’s time to modify it by adding a 

Noise Modifier. Select the Plane, go to the Modify 
panel and select Noise Modifier. Now make 

Creating a plane to emit smoke

Creating a plane to emit smoke
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the following changes: Scale: 3.0, Strength X: 
12.5, Y: 12.5 and Z: 25. Now go to the Animation 
section and turn on Animate Noise, then set the 
Frequency to 3.0. Now you can see the Plane with 
animated noise applied, and you’re ready to use 
it as fire and smoke emitter.

03 Create a FumeFX Object Source: After 
finishing the modeling and modification 

of our object, it’s time to proceed to the FumeFX 
plugin. So first of all we will create the FumeFX 
Object Source where we will add our Object. 
To create a FumeFX Object Source, go to Create 
Panel > Helpers > FumeFX > Object Src. Click on 
this button and drag it into the viewport. Now go 
to the Modify panel to make some changes in the 
Parameters. Change the Object Src Type to Solid. 
Set the Smoke to 25.0, then go to the Velocity 
section and set Object’s to 5.0 and Extra to 15.0. 
Keep the other parameters as they are.

04 Create a FumeFX Container: We are 
going to use FumeFX as it’s very simple to 

use, but still has many options and parameters. 
We’ll cover as much as is required for this 
particular tutorial.

So let’s start with the FumeFX Container. Go to 
the Create panel and select Geometry > FumeFX > 
FumeFX. Click on the FumeFX button and drag it 
into the viewport, then go to the Modify panel and 
set the Size and Spacing as follows. Width: 400, 
Length: 400, Height: 600 and Spacing: 1.2.

Now set the Position of FumeFX to the following: 
X: 00, Y: 00, Z: 00.

05 Create a Wind Force: To push the fire 
and smoke in a certain direction, we’ll 

use Wind. To create this, go to the Create panel 
and select Space Warps > Forces > Wind. Click on 
it and drag it into the viewport, then change the 
Strength to 2.0. 

Now set the Position of FumeFX to X: 250, Y: 00, Z: 
150. Set the Rotation X: 0.0, Y: -90, Z: 0.0.

06 Modify the FumeFX Container: After 
setting up the FumeFX Container, it’s time 

to modify the parameters. So select the Container 
and go to the Modify panel. Now click on the 
‘Open FumeFX’ UI button and a new window will 
appear. As you can see, there are six sections in 
this FumeFX interface and we will modify them 
one by one. So let’s start with the Obj/Src section. 
In this section you just have to add the FumeFX 
Object Source which we generated earlier. So go 
to the Obj/Src section and click on the Pick Object 
button, then select the FumeFX Object Source 
and Wind Force.

The FumeFX Object Source

Creating a FumeFX Container

Adding Wind Force to move the smoke
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07 FumeFX – General Parameters: After 
finishing the setup of the Obj/Src section, 

let’s set up the General Parameters section. 
We have already the set General Parameters to 
Spacing: 1.2, Width: 400, Length: 400 and Height: 
600. Now we’ll move ahead to the Output Range, 
set the Start Frame: 0, End Frame: 200, then go 
to Paths, where we set the FXD Files (Cache Files) 
path. So click on the button which is next to the 
Default Path and set the path as per your Folder 
Structure. Now move ahead to the Playback 
Range and set the Play From as 0 and Play To as 
200. So these are some simple modifications in 
the General Section.

08 FumeFX – Simulation Parameters: 
After finishing the setup of General 

Parameters, let’s modify the Simulation 
Parameters. Go to the Simulation tab and apply 
the following settings. Change the Vorticity 
to 1.0 and the X Turbulence to 0.5. Now go to 
Turbulence Noise and set the Scale to 2.0, Frames 
to 1.0, and Details to 5.0.

Now go to Fuel and increase the Expansion to 2.0, 
keeping the other parameters as they are. Then 
go to Smoke and set the ‘Dissipation Min. Dens.’ 
to 5.0 and Dissipation Strength to 5.0 to dissipate 
the smoke fast. Keep the other parameters as 
they are and hit the Simulation button. It will take 
around 3-4 hours to finish.

Setting up FumeFX’s Simulation section

Modifying the FumeFX Container Going through FumeFX’s General Parameters section
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09 FumeFX – Rendering Parameters: After 
finishing the simulation, just make sure 

that everything is as per your requirements. Now 
it’s time to set the colors of the fire and smoke. So 
go to Rendering section and select the Fire tab. 
Right-click on Color and change it to Key Mode, 
then change the Gradient Color as shown in the 
image. Now move on to the Smoke Parameters. 
Set the smoke color to gray and reduce the 
Opacity to 0.5, then turn on the Cast Shadows 
and Receive Shadows options (so when we add 
the light, we should see the smoke’s shadow).

10 FumeFX – Illumination Parameters: 
After finishing the Color settings, it’s 

time to add light to the scene. We’ll create two 
lights: one Target Spot and one Omni Light. To 
do that, go to the Create panel and select Lights 
> Standard > Target Spot. Click on the Target 
Spot light and create it in viewport. Now set the 
light position to X: -1850, Y: -1035, Z: 1950, and its 
Target Position to X: 20.0, Y: -15.0, Z: 200.0. Create 
the Omni Light with same procedure and change 
its Position to X: 825, Y: -600, Z: 550. 

Now select the lights and go to Modify panel, 
then turn on the Shadow and set it to Ray Traced 
Shadows. Now go to Shadow Parameters and 
turn on Atmosphere Shadows. After finishing 
these settings, return to FumeFX Container. Go to 
the Illumination section and add these lights into 
the Light section by clicking the Pick Light button. 
Now turn on Multiple Scattering, set its Max 
Depth to 8 and Falloff to 8.0, and leave the other 
parameters as they are.

Selecting a color for the smoke

Adding light to our smoke effect

http://www.3dcreativemag.com


3DCREATIVE MAGAZINE   |  ISSUE 125

91

11 Rendering: After finishing the light 
setup, it’s time for rendering. Go to 

Render Setup by pressing F10 and set your 
desired Output Range, Output Resolution and 
Output Path. Go to the Render Elements tab 
and click on the Add button, bringing up a new 
window. Select the FumeFX Fire and FumeFX 
Smoke elements and click OK. Now just hit the 

Render button. It will take around 4-5 hours to 
finish rendering.

12 Post-production: After finishing the 
rendering, import both the fire and 

smoke renders into After Effects, or any other 
compositing software which is convenient for you. 
I’m using After Effects, so import both elements 

and drag them into the timeline. Select the fire 
element, then right-click and change its Blending 
Mode to Add. You can include Glow effects and 
make some changes in the Parameters. Select 
the smoke element and make whatever changes 
you like to the color or brightness settings. 
Now render the final output and you’ll get your 
finished thick smoke!

The render settings for the final smoke effect

Adding final post-process tweaks in After Effects
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The Artist

Vikrant J. Dalal
project01studio.blogspot.com

TOP TIP 
Always use Noise Float Controller
Wind doesn’t travel at a constant 
speed, so to get this effect, you need 
to animate the Wind Strength on 
every frame or after every five frames, 
which is very time-consuming and 
hectic. Instead, do this using Noise 
Float Controller to save time: just 
right-click on Strength and select 
‘Show in Track View’. A new window 
will appear with the Strength option 
selected. Right-click on this and 
select Assign Controller; in the new 
window, select Noise Float, and 
another window will appear with 
the Noise parameters. You have to 
try these parameters to achieve the 
effect you want.
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Sculpting
realistic animals
Stavros Fylladitis reveals the ZBrush and Maya techniques 
behind his superbly lifelike elephant model

The Artist

Stavros Fylladitis
stavrosfyl.artstation.com

Software Used:
ZBrush, Maya

Stavros Fylladitis is a 3D 
artist based in Athens, 
Greece. He has worked for 
IXOR Visual FX and Faust 
VFX, and has a special 
interest in modeling.
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Improve your ZBrush sculpting 
with these insights from 
Stavros Fylladitis…

In this tutorial, I’m really excited to share with 
you the process and techniques I used for my 
latest personal project, African Elephant. I 
learned a lot and would like to pass some of 
the knowledge and experience I’ve gained on 
to the CG community.

01 Reference: A lot of people get too 
excited at the beginning of a project and 

they want to dive into the fun and interesting 
stuff right away. What I’ve learned to do, and has 
helped me a lot, is to take some time to study 
what you are about to do. Where does the animal 
live? How does it look when it’s born or when it 
gets old? A lot of these things play a huge role in 
the shape of its body, the way it walks, and most 
of all they give you a huge advantage because 
you can easily give a personality to the animal 
and bring it to life.

I’ve come to the conclusion that your model will 
go as far as your references. Go through anatomy 
books, visit zoos, watch documentaries, browse 
Pinterest. Spend some time to find the best 
references you can find out there. Always keep in 

mind the ‘80-20’ rule: the 20% of work you do in 
the beginning will determine how the other 80% 
will look. After finishing with the references I use 
PureRef to have them next to me all the time. It’s 
a free image viewer where you can display a lot of 
images without any distractions.

02 Skeleton: The best way for me to 
understand an animal is to start working 

on it from the inside. That’s why I almost always 
start with the bones. You don’t have to go crazy 
here, just some simple geometry with the basic 
forms and volumes of the bones will do the job. 

Reference material laid out in PureRef

Building up the elephant’s structure, starting with the skeleton
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Adding muscle mass to the elephant’s skeleton

Building up the surface forms of the body
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But since it was a personal project and I had the 
time, plus I love making bones, I took it further. 
The process I use here is back and forth between 
ZBrush and Maya. I usually build a low-poly 
silhouette of the bones in Maya and then detail 
them using DynaMesh and ZRemesher in ZBrush.

03 Musculature: When your skeletal 
structure seems good to go, it’s time to 

move on to the muscles. From here you can take 
a variety of approaches. What I prefer to do is to 
block out the main muscles with DynaMeshed 
spheres – not anything fancy, but enough 
information to represent the main muscle groups 
on top of the bones.

04 Working on the body: When I have 
finished the muscles and bones, I like 

to DynaMesh everything together. The key here 
in the density of the mesh is to have enough 
information to see the muscle groups, but also 
low enough density that you can move big forms 
easily. Here is the point where I have the base 
structure of the body, and from there I start to 
build the forms. 

Here is the part of the process where you have 
to decide the body type of your animal: whether 
you want it skinny with bones and ribs that stick 
out on the surface, or fatty enough to cover the 
muscles and bones.

05 A quick note on brushes: Here you 
can see how the elephant’s surface 

details were built up very gradually, making sure 

An overview of the sculpting and detailing process

Some of the brushes used to create these sculpts
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the larger forms were prepared before starting 
on adding the refinements. The main brushes 
that I’ve used here, and basically throughout the 
whole sculpt, are the Smooth, Smooth Valleys, 
Clay Buildup (with and without its square alpha), 
Move, Move Topological, Dam Standard and 
finally, Inflate.

06 Retopology and UVs: For retopology 
I used Maya’s tools, which help speed 

up my workflow. Since I knew that I was going to 
have a close-up image of the elephant’s head, I 
tried to have more information on the head so I 
could sculpt higher frequency details compared 
to the body. I used UVLayout for the UVs.

07 Skin and details: The skin of the 
elephant was the trickiest and most 

challenging part for me, but also the most 
enjoyable. I wanted it to be as realistic as 
possible. I saw a lot of tutorials online about 
modeling elephants and how to approach them, 
but none of them had correct and realistic skin. 

The retopologized model and its UVs
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Most people tend to use alphas right away and 
the result is usually not what they were going 
after. I spent some time doing studies on how the 
skin works, how traditional sculptors approach 
it, and I ended up sculpting nearly all of the 
elephant’s surface details by hand. I used 16-bit 
alphas only for the high frequency details and to 
give a little surface noise.

If the forms, muscles and big skin folds are not 
correct or they aren’t there at all, no matter how 
much detail you put on a model, it will always 
look like something is odd and unpleasant about 
it. Spend some extra time making sure that 
everything is in the right place by going back and 
forth with the subdivision levels before you start 
going crazy with the details.

08 Hair: I didn’t want to complicate the hair 
a lot, so I went with ZBrush’s FiberMesh. 

For the kind of fur that I wanted, it had pretty 
decent results.

09 Rendering and post-production: 
For the rendering I used V-Ray in Maya. 

With a simple area light and some time to find 
the desired camera angle, I got the result I was 
looking for. In Photoshop I adjusted the tones a 
bit to bring some more contrast to the image, and 
then it was done. 

Sculpting skin 
details and 
wrinkles

Adding some hair to the 
elephant’s skin with FiberMesh
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The Artist

Stavros Fylladitis
stavrosfyl.artstation.com

A close-up render of the final model
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